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Test Series Module 2 - Creating Designs with Shapes in MS Word

Definition

The Insert Menu in MS Word is a feature that allows users to add various elements
such as tables, images, charts, text boxes, and other objects into a document.
This menu helps enhance the document's structure, readability, and visual appeal.
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Test Series Use of Shapes in MS Word

We use Shapes in MS Word to make documents
more visually appealing, organized, and easy )

to understand. Here are some key reasons J
why shapes are used:
To Enhance Presentation

¢ Shapes like arrows, boxes, and circles can .
e highlight important points in a document. -

¢ Used for decorative elements to improve ‘
e document design.

To Create Diagrams & Flowcharts

e Shapes help in creating organizational
charts,

e process diagrams, and workflows.

e Useful for business documents, educational
e materials, and technical reports.
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_ Insert a Shape:
e Open MS Word and go to the Insert tab. ﬂ’ I
e Click on Shapes (in the Illustrations group).
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Test Series PR, Shape in MS Word

You can rotate a shape in MS Word using
the following methods: 451
Method 1: Using the Rotate Handle (Quick
Method)

Insert a Shape:

¢ Go to the Insert tab — Click Shapes — ‘ I

CBSE

Select and draw a shape.

Rotate the Shape:

« Click on the shape to select it.

o A circular arrow (&) appears at the top
of the shape.

« Click and drag this handle left or right to rotate the shape freely.

|:

Helping Tool of Shapes

The Format Menu in MS Word provides tools to customize the appearance of text,
images, shapes, and other elements in a document. It helps improve readability,
— Banking & design, and overall presentation.
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W W\ The "Edit Shape” feature in MS Word allows users to [ﬂwM' P —

O PP modify an existing shape by changing its form, ; @ Ch sh ' ’
adjusting its points, or converting it into another ‘ NS SNepe
shape. This is useful for customizing diagrams, dit Point
flowcharts, and creative designs. £ Edit Points

- t;: Reroute Connectors

ULLCON Reroute Connectors

A connector is a line that links two shapes. Unlike a normal line, a connector stays
attached to the shapes even if you move them.

T IIT R T Reroute Connectors automatically change the connector’s path to avoid overlaps
S TLTLTEN or create the shortest path between shapes.
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Test Series This is especially useful in flowcharts, diagrams, and organizational charts where

connectors need to avoid overlapping or tangled paths.

How to Use Reroute Connectors

1. Insert Shapes

1. Go to Insert — Shapes — New Drawing Canvas.

2. Select a shape (e.g., Rectangle, Oval).

3. Draw two or more shapes on your slide/document.

|

. Add Text to Shapes

Right-click a shape.

Choose Add Text.

. Type your desired label (e.g., "Start” and "End").

W NN

3. Connect Shapes
1. Go to Insert — Shapes and select a Connector (like Elbow Connector or
Straight Connector).

2. Hover over the first shape until you see connection points (small dots).

3. Click a connection point on the first shape, then drag to a connection point on
the second shape.

— Banking &

Insurance

Reroute Connector

4. Reroute the Connector

« If you move the shapes, the
connector may twist awkwardly.
 To fix it:

1. Select the connector line.

2. Right-click and choose Reroute
m State Govt. Iy

LALECN 3. The connector will automatically
adjust to take a cleaner or shorter
path.
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NOTE: This is especially useful in flowcharts and diagrams to keep them neat.

MBA Shape Styles in MS Word csoocooon
AN Shape Styles in MS Word are predefined formatting =] (e oo
options that allow users to customize the appearance - P —
I:I of shapes, such as rectangles, circles, and arrows. =~ @@ @ —
Railways & Metro a1y s . = a .
St el Shape Fill in MS Word o ooay
Shape Fill in MS Word lets you add color, gradient, Otter Theme s

texture, or pattern to a shape’s interior for
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Test Series customization. It offers various options to enhance the visual appearance of shapes

and make them more dynamic in your document.

No Gradient

Gradient - Shape Fill

A Gradient in MS Word is a color effect that blends
two or more colors smoothly within a shape. It
enhances the visual appeal of shapes, making them
more attractive and professional.
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Test Series

CBSE Shape Outline ||2$hape0uﬂine ~| L—j
In Microsoft Word, a shape outline refers to the border Theme Colors

or the edge of a shape, such as a rectangle, circle, or E EEEEsEE
any other shape inserted into the document. The
outline helps define the boundaries of the shape and

can be customized in terms of color, thickness, style, . I I I I l l l l l

and other visual properties.
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WordArt Styles in Microsoft Word are pre-designed text effects that let you create
decorative and visually appealing text. These
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FORPREFPSA In Microsoft Word, Shape Effects are special visual et | 4
Service enhancements that can be applied to shapes, such as D WL
text boxes, autoshapes, or drawn.objects. These effects | ——
I:I can make your shapes stand out and improve the I ] snadow .
overall design of your document. T
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I:I WordArt Styles
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LLLLEERN « Text Fill - Allows you to fill the text with A A ST/ A
solid colors, gradients, textures, or pictures. N
* Text Outline - Adds a border around the text | /= A /: A
CPTY T with different colors and thicknesses. &0

S TUULTTIN o Text Effects - Applies effects like shadows,

reflections, glows, 3D rotation, and bevels. /&\ A A A A
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Test Series e Transform - Lets you bend, stretch, or shape the text into different forms (e.g.,

wavy, circular).

Text Fill A Text Fill - | ||2 Text Dird

B 2utomatic

Text Fill is a formatting feature in Microsoft Word that
. Theme Colors
allows you to change the color, gradient, texture, or even
4 o ; . HE EEfEEEN
use an image inside the text. It is commonly used in
WordArt to create decorative text.
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ervice Text Outline is a feature in Microsoft Word that allows HE EEEEEN

you to add a border or stroke around text. It is commonly
used in WordArt to make text stand out with different
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Test Series

Text Effects = | == Cf

Text Effects

Shadow .4

Text effects in MS Word enhance text with visual styles such
as shadows, glows, reflections, and 3D effects. These
effects help make text stand out and improve its visual
appeal in documents.

Reflection »
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Glow .4
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4% 3-D Rotation »
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é‘m Transform »

GO, 1) i Text Direction == Align Text - |
_ Text Direction in Microsoft Word allows you to change the — -
orientation of text in tables, text boxes, and shapes. You ~9R
— Banking & can rotate the text vertically, horizontally, or at an-angle.
Insurance
(T e Text Alignment in Microsoft Word allows you to position
Service text horizontally and vertically within a document, table,
I:I text box, or shape. L Bottom
o Stgte Govt.
ervices .
Create Link
You can add a hyperlink to text inside a text Text in the
box in Microsoft Word to link to a website, firet shape
4 LAW email, another document, or a specific section P Flow of text

= Entrance RITINTRINS same document. !

Linking Shapes with Flowing Text in Word Second

MB

T Step 1 - Insert the First Shape

1. Go to Insert — Shapes.

2. Pick a shape (e.g., Rectangle, Rounded
Rectangle, or any closed shape). Third
3. Draw the shape on your page. shape
4. Right-click — Add Text (or just start

typing).

shape

—
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Making Marketing Designs in MS Word

Step 2 - Insert the Second and Third Shapes
1. Repeat the same steps to insert two more shapes anywhere in the document.
2. Add placeholder text if you like, or leave them empty for now.

Step 3 - Link the Shapes Together

1. Click inside the first shape to select it.

2. On the Shape Format tab (appears when the shape is selected), find the
Create Link button in the Text group.

o In some versions of Word, you may need to go to Drawing Tools — Format to see
it.

3. Click Create Link — the cursor changes to a pitcher icon.

4. Click inside the second shape.

5. Repeat the process:

o Select the second shape.

o Click Create Link.

o Click inside the third shape.

How It Works

« If the first shape’s text overflows, the extra text flows automatically into the
second shape, then into the third.

» Resize or move shapes freely — the links still work.

» Change colors and outlines via Shape Format — Shape Fill / Outline.

Position

In Microsoft Word, you can control the position of text,
text boxes, images, and other objects to create a well-
organized document layout.

= [k Bring Forward

B

[ send Backward
|Positior1 Wrap

Text ~ %Selection Pane|
|| Im Line with Text

ksl

With Text Wrapping
k=l f=l k=l
k=l k=l k=l
= == =

T More Layout Options...
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Test Series Wrap Text

Wrap Text in Microsoft Word controls how text flows
around images, text boxes, tables, and other objects. This -l []
feature helps position objects more flexibly within a Wrap | Bring Send S
document. Text ~ |Forward ~ Backward ~

12}

In Line with Text
Square

Tight

1 ]
o

Through
Tep and Bottom
Behind Text

|n Front of Text

Dy 1000 0 0 8l 1 1

Edit Wrap Points

<

Move with Text
Fix Position on Page

More Layout Options..

|

Set as Default Layout

: Bring Forward
al Banking & The "Bring Forward" option in Microsoft Word is used

LETLEEEIN to move objects (such as images, text boxes, shapes, | Bring Forward | | Align
_ or WordArt) to the front of the document layout, e T
placing them above other elements. 4] Bring Forward
Central Govt. L :
ervice 4 Bring to Front

I

?j Bring in Front of Text

o Stgte Govt.
e . .
AL Send Backward E— . ﬁmd R 1,
The "Send Backward" option in Microsoft Word is-used to

move objects (such as images, text boxes, shapes, or L&  Send Backward
i LAW WordArt) behind other elements in a document. This B sendto Back
=S YT - helps organize overlapping objects. -

\ &b sendBehind Text
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Selection Pane v =
The Selection Pane in MS Word allows you to view, e s =
select, and organize objects such as shapes, text

boxes, and images in your document. It provides a

simple way to hide, show, or reorder objects for

better document management.

Group in MS Word

The Group feature in Microsoft Word allows you to
combine multiple objects (such as images, text
boxes, shapes, or WordArt) into a single unit. This
makes it easier to move, resize, or format them.

Rotate in MS Word ———
In MS Word, the "Rotate” feature lets you turn _
shapes or objects to any angle, either manually or by J«) poiater  e=s 4057

using preset options like 90-degree rotations. This
helps adjust the orientation of shapes to fit your
document'’s design. A7 Rotate Left 907

“h Rotate Right 90°

= Flip Vertical
Align in MS Word d
In MS Word, the "Align" feature allows you to position
shapes relative to each other or the page, ensuring
they are evenly spaced and organized.

Flip Horizontal

T More Rotation Options...

Height and Width
In Microsoft Word, you can adjust the height and width of images, text boxes,
shapes, tables, and other objects to ensure they fit properly in your document.
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